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Introduction to the 
CS420000 Compass 

he Digital Compass Sensor magnetically indicates the four Cardinal (N. E, S. 
W) directions, and the four intermediate (NE, NW, SE, SW) directions. The 
Compass Sensor is compatible with the C Stamp microcomputer’s supplies 
and signal levels. Acquiring a direction from the sensor is made easy with A-

WIT's supplied software command COMPASSIN. This simple one command 
interface is all that is required to interrogate the Compass. 

Registering Your C Stamp or C Stamp Related 
Product 
At A-WIT Technologies we respect your privacy; however, we do ask you to register 
your C Stamp or C Stamp related product, so you can receive free of charge product 
updates. The registration procedure is simple. Just send an e-mail to tech_support@a-
wit.com with the word “REGISTRATION x” in the subject line, where “x” is the 
product number that you purchased. If you purchased more than one product, send an 
e-mail for each different product. 

Introduction to the CS420000 Compass 
The Digital Compass Sensor magnetically indicates the four Cardinal (N. E, S. W) 
directions, and the four intermediate (NE, NW, SE, SW) directions. The Compass 
Sensor is compatible with the C Stamp microcomputer’s supplies and signal levels. 
Acquiring a direction from the sensor is made easy with A-WIT's supplied software 
command COMPASSIN. This simple one command interface is all that is required to 
interrogate the Compass. 

Technical Specifications 
• Sensitive to horizontal component of the Earth's magnetic field. 
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• 8-direction resolution. 

• Does not need to be calibrated. 

• Only 0.5 to 1 second between start measurement and data-ready with simple 
A-WIT supplied software interface. 

• Flexible 5 - 20 V power supply requirement. 

• Flexible and low power Open-Collector data pins. 

• Compact and breadboard-friendly. 

• Compatible with C Stamp microcomputer. 

Application Ideas 
• Mobile and walking robot direction sensor. 

• Handheld electronic compass. 

• Vehicle electronic compass. 

• Weathervane indicator for remote weather stations. 

• Audible compass for the vision impaired. 

General Information 
The Digital Compass Sensor magnetically indicates the four Cardinal (N. E, S. W) 
directions, and the four intermediate (NE, NW, SE, SW) directions. The Compass 
Sensor is compatible with the C Stamp microcomputer’s supplies and signal levels. 
Acquiring a direction from the sensor is made easy with A-WIT's supplied software 
command COMPASSIN. This simple one command interface is all that is required to 
interrogate the Compass. 

The Sensor is a combination of a subminiature rotor jewel suspended in combination 
with solid state Hall-effect IC's. The Sensor was designed to indicate the direction of 
the horizontal flux pattern (Compass component) of the Earth's field thus becoming a 
compass. The Sensor is damped to give the same speed indication as a liquid filled 
compass, that is, 0.5 second response from 90° displacement without over-swing. It 
has built-in hysterisis to prevent indication "flutter" when near a switching direction. 
The Sensor will accept input power between 5.0 and 20.0 Volts, but should be polarity 
and “spike” protected from a vehicular power supply. The output is an “open 
collector” NPN transistor which will sink up to 25 milliamps per direction. The Sensor 
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is low cost and reliable. The Sensors is based on Hall-effect technology and can be 
mounted remotely. Also, all Sensor outputs can be used in stand-alone applications. 
The Sensor may be operated from input voltage of 5 to 20 Volts DC with 8 to 13 
Volts recommended. Input should be both “spike” and polarity protected. Power 
requirement is approximately 1 to 30 milliamps. Each output will sink up to 25 
milliamps. The Sensor will switch so that no more than two adjacent output channels 
are asserted at any one time. Each output is an open collector NPN transistor pulling 
the output to ground, and thus it does not add to the input current requirements. The 
Sensor is internally designed to respond to directional change similar to a liquid filled 
compass. It will return to the indicated direction from a 90° displacement in 
approximately 0.5 to 1.0 seconds with no over-swing. The Sensor should be operated 
in a vertical position. The Sensor indicates the horizontal component or compass 
component of the Earth’s magnetic field. If off the vertical position, some of the 
vertical component of the earth’s field is introduced which may create some directional 
error. Generally, tilt up to 12° is acceptable with little error. The Sensor is 
manufactured for pins down operation, but it operates equally well pins up or down. 
The Sensor weighs approximately 2.25 grams. The operating temperature is -20° C to 
+85° C. The sensor may be stored without damage in wider temperature limits and 
may be subjected to high flux levels (up to 1000 gauss) without permanent damage. 
The pins are on 0.050 inch centers but may be distorted for 0.100 inch spacing without 
damage to the sensor or its measurements. The four VCC and four grounds may be 
common connected. 

The following figures describe the Sensor and its pin-out connectivity. 
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Px represent connections to any four C Stamp I/O pins that interface the compass to 
the C Stamp. 
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Getting Started 
his chapter is a quick start guide to using the CS420000 compass with the C 
Stamp. This assumes you have a C Stamp and an appropriate connection kit 
or development board with the RESET and START circuitry, 8 LEDs 
connected to the C Stamp, the compass properly connected to the C Stamp, 

and an optional utility input button circuit. You will also need a programming cable, 
power supply, PC running Windows® 2000/XP/Media, with a quantity of RAM 
recommended for the OS, sufficient free hard disk drive space for the software 
installations, CD-ROM drive, Internet access (recommended only), and available port 
compatible with your programming cable. 

Notices 
CSTAMP™ and CSTAMP™ Related Hardware Products, Software 
Products and Documentation are developed and distributed by A-WIT 
Technologies, Inc. All rights reserved by A-WIT Technologies, Inc. A-WIT 
SOFTWARE OR FIRMWARE AND LITERATURE IS PROVIDED 
“AS IS,” WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL A-WIT BE LIABLE FOR ANY CLAIM, DAMAGES 
OR OTHER LIABILITY ARISING OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR FIRMWARE OR THE USE OF 
OTHER DEALINGS IN THE SOFTWARE OR FIRMWARE. 

MPLAB C-18 and MPLAB C-18 Users Guide is reproduced and 
distributed by A-WIT Technologies, Inc. under license from Microchip 
Technology Inc. All rights reserved by Microchip Technology Inc. 
MICROCHIP SOFTWARE OR FIRMWARE AND LITERATURE IS 
PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO 
THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO 
EVENT SHALL MICROCHIP BE LIABLE FOR ANY CLAIM, 
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DAMAGES OR OTHER LIABILITY ARISING OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR FIRMWARE OR THE 
USE OF OTHER DEALINGS IN THE SOFTWARE OR 
FIRMWARE. 

Getting Support 
If possible, please check the C Stamp website www.c-stamp.com under SUPPORT for 
any updates to documentation, changes, or notices that may have become available 
since your Installation CD was produced. If you continue to have any issues for which 
a solution is not found in the aforementioned website, please e-mail tech_support@a-
wit.com for help. 

Installing the Microchip MPLAB and C Compiler 
Software 
The first step is to install the Microchip MPLAB software that you will use to develop 
your programs. 

Insert your A-WIT provided Installation CD in your CD drive. Go to the MPLAB 
directory in the CD and double click on the “MPLAB vX.XX Install” file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

After the MPLAB installation is complete, switch to the C18 directory in the CD, and 
double click on the file in that directory. Follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. The only 
exceptions to accepting all the default options is that on the 5th and 6th windows of the 
installation process for the C18 Compiler, you have to select everything as shown in 
the figures below. This will ensure that MPLAB is configured to use the C18 Compiler. 
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Installing the A-WIT C Stamp Quick Programmer 
To install the A-WIT C Stamp Quick Programmer, switch to the CSTAMPQP 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Installing the USB Software 
If you purchased a product with a USB download cable, make sure that the A-WIT 
provided CD is in the CD drive of your PC and insert the USB cable in the USB port 
of your PC. Windows auto detects the new USB device. If Windows prompts you to 
install drivers for the USB cable device, follow the installation steps, prompts, and 
directions provided by the installer software, accepting all the default options. 

After the USB adapter has been installed, open a Windows Explorer window from the 
Accessories sub-menu in the Start menu, and right click on My Computer. Proceed to 
select Properties, and then select the Hardware tab. Click on the Device Manger 
button, and expand the Ports (COM & LPT) branch. Make a note of the COM port 
that has been assigned to the USB-to-Serial adapter. This is the port that should be 
selected in the C Stamp programmer software. 

Setting Up the C Stamp Software Templates 
To set up the C Stamp Software Templates, switch to the CSTAMP_Template 
directory in the CD using Windows Explorer, and double click on the file in that 
directory. Follow the installation steps, prompts, and directions provided by the 
installer software, accepting all the default options. 

Documentation 
Copy the DOCS directory from the C Stamp Installation CD to your C:\A-WIT 
directory. This directory contains all the C Stamp related documentation in PDF 
format. 
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Creating your Compass C Stamp Program 
Create a directory where you want to have all the files for your program; for example, 
COMPASS_APP. We recommend making this directory under your C:\A-WIT 
directory, so you can have all your CSTAMP related files in one place. 

Copy the all files in your C Stamp Software Templates directory C:\A-
WIT\CSTAMP_Template to the directory you just made. 

Open the Microchip MPLAB IDE application. As shown the following figure, the 
IDE has several sub-windows. Depending on the resolution of your screen, your sub-
windows may have a different layout. However; you can move and resize these into the 
position that you want to fit your screen, and your layout for that particular project will 
get saved upon answering yes to the prompt of saving the workspace when you exit 
the software development environment. 

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

PROJECT

SUB-

WINDOW

OUTPUT SUB-WINDOW WATCH SUB-WINDOW

EDITING

SUB-

WINDOW

 

 

Go to the “File” menu to “Open Workspace…”. Then navigate to your program 
directory, and open CSTAMP_Template.mcw. 

Right click on CSTAMP_Template.mcp in the “Project” sub-window, and “Save 
as…” the name of your program project after you have navigated to your program 
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directory. For example, your program project could be named “COMPASS_APP”. 
Now when you open the Microchip MPLAB IDE (Integrated Development 
Environment), and go to your program directory to open the workspace for your 
program, you will see a .mws file with the name of your program preceding it. This is 
the file that you should open any time you want to work on your program. 

Double click on the main.c source and type the following code fragment where it is 
indicated. You can omit the comments for brevity, as they are written here to offer 
clarifications of what the code does. Do pay attention; however, to the indentation of 
the code blocks between curly brackets for loops, if statements, etc. Although 
indenting the code is not a requirement for the compiler to parse your code (i.e. any 
blank spaces are ignored by the compiler), it does help tremendously to make your 
code much more readable, and consequently, it makes finding any errors easier. 
Keywords and function names in the code fragment below are bolded. 

After you START the C Stamp in user mode as explained in the “Downloading and 
Running Your Program” section (this will not be the RESET/BOOT/DOWNLOAD 
mode), the program will run. This program assumes that your eight LEDs are 
connected to C Stamp pins 39 through 46. The program starts by ensuring that all 
LEDs are off and waits for the utility button at pin 38 of the C Stamp to be pushed. 
The program then interrogates the compass continuously and lights up one LED per 
direction. Each LED corresponds to one of the directions that the compass detects. 
The C Stamp support circuitry described to use this compass application is essentially 
the same described in the “Getting Started” chapter of the “C Stamp Syntax and 
Reference Manual”. The program executes indefinitely until you restart it by pushing 
and releasing the RESET button while holding the START button and then letting go 
of the latter. 

// Declare some necessary variables 
  BIT button_pushed;  // For optional button 
  NIBBLE direction; 
 
// Turn off LED's connected to the following pins 
// Assumes that a HIGH outputs light up LEDs 
STPIND(46, LOW); STPIND(45, LOW); 
STPIND(44, LOW); STPIND(43, LOW); 
STPIND(42, LOW); STPIND(41, LOW); 
STPIND(40, LOW); STPIND(39, LOW); 

 
// Wait for button connected to pin 37 to be pushed 
// Can be omitted, if a utility button is not used 
  button_pushed = FALSE; 
  while(!button_pushed){ 
    button_pushed = BUTTON(37, LOW, HIGH, 5); 
  } 
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  while(1){ 
// Check compass 
// Assumes that N compass output is connected to C 
// Stamp pin 1, E to C Stamp pin 2, S to C Stamp pin 3, 
// and W to C Stamp pin 4 
    direction = COMPASSIN_CS420000(1, 2, 3, 4); 

// Light up the LED corresponding to the direction 
// detected by the compass 
// Assumes that a HIGH outputs light up LEDs 
    switch(direction){ 
      case COMPASSIN_N:  STPIND(39, HIGH); break; 
      case COMPASSIN_NE: STPIND(40, HIGH); break; 
      case COMPASSIN_E:  STPIND(41, HIGH); break; 
      case COMPASSIN_SE: STPIND(42, HIGH); break; 
      case COMPASSIN_S:  STPIND(43, HIGH); break; 
      case COMPASSIN_SW: STPIND(44, HIGH); break; 
      case COMPASSIN_W:  STPIND(45, HIGH); break; 
      case COMPASSIN_NW: STPIND(46, HIGH); break; 
    } 
  } 

Save your program from the “File” menu or by clicking on the appropriate icon in the 
tool bar. Then “Build All” from the “Project” menu or from the tool bar. 

If the code was typed correctly, you will have a file in your program directory with the 
name of your program project and a .HEX extension. An example is 
COMPASS_APP.HEX. This is the file that you will download to the C Stamp, as 
explained up ahead. 

If you get an error message or an indication that your program did not build 
successfully in the “Output” sub-window of the IDE, you probably have one or more 
syntax error(s). Double click on the line of the “Output” sub-window that mentions 
the error, and the program line that most likely contains the error will be indicated in 
the sub-window where you were editing your program. Correct as necessary, and 
“Build All” again until you get a successful .HEX file output. 
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Downloading and Running Your Program 
Power up your KIT, and connect the KIT to the PC with the provided cable. Upon 
power up, the C Stamp will be in RESET/BOOT/DOWNLOAD mode. To go back 
to this mode at any time, just push and let go of the RESET button. Then open the A-
WIT C Stamp Quick Programmer application shown in the next figure. 

 

 

The first step is to choose the serial port that you are using from the drop-down menu. 
Then click on “Refresh”, so that the program registers your selection. Your selection 
should show in the status area of the program next to “PORT:”. Then click on “Open 
HEX File” and load/select the HEX file that you had previously created during the 
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development of your program. The status are should indicate that the file has been 
loaded successfully. This is what will be downloaded to the C Stamp. Then click on 
“Connect”, and the PC will be connected to the KIT, and the status area should 
indicate so. To download the HEX file to the C Stamp, just click on “Write Device”, 
and you should see the progress bar after a few seconds, as the HEX file is 
downloaded. At this point, you can click on “Disconnect” to disconnect the PC from 
the KIT, disconnect the serial cable from both the PC and the KIT, and start your 
program manually at the KIT. To do this just push and let go of the RESET button 
while pushing the START button. Then you can let go of the START button. 
Alternatively, you can click on “Normal Mode” to start your program from the PC. 
This will also disconnect the program/PC from the KIT. Then you can disconnect the 
serial cable from the PC and the KIT. You can also instruct the CSTAMP™ Quick 
Programmer to wait several seconds before starting your program from the PC and 
disconnecting by adjusting the “SECONDS TO START” slide. This feature is useful 
in case you want to keep the PC connected with the serial cable, but need time to 
manually set up something in a circuit that you have built. If this is not the case it can 
just be left at the default of “0”, and your program will started from the PC right away. 
After you click “Normal Mode” and your program is started, the CSTAMP™ Quick 
Programmer will not be communicating with the C Stamp any longer, so if you want 
to reconnect, you must click on “Connect” again. 
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Accessory Specific 
Functions and Commands 
Reference 

his chapter describes the functions and commands that are specific to the 
software support of different types of accessories that are available from A-
WIT Technologies to complement the function and projects developed with 
the C Stamp. The user should consult the manual for a specific accessory for 

full information on connectivity and usage. 

COMPASSIN_CS420000 
NIBBLE COMPASSIN_CS420000(BYTE Npin, BYTE Epin, 

 BYTE Spin, BYTE Wpin); 

The COMPASSIN function returns a direction by querying a CS420000 Digital 
Compass Sensor that is connected to the C Stamp. 

Npin is a variable/constant/expression that specifies the I/O pin that is connected to 
the North Signal of the compass. This pin will set to input mode. 

Epin is a variable/constant/expression that specifies the I/O pin that is connected to 
the East Signal of the compass. This pin will set to input mode. 

Spin is a variable/constant/expression that specifies the I/O pin that is connected to 
the South Signal of the compass. This pin will set to input mode. 

Wpin is a variable/constant/expression that specifies the I/O pin that is connected to 
the West Signal of the compass. This pin will set to input mode. 

On exit, the function returns one of the following exit codes. 

Chapter 
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return code value Meaning 

COMPASSIN_ERROR 0 There was at least one error while executing the 
function. 

COMPASSIN_N 1 Direction is North. 

COMPASSIN_NE 2 Direction is Northeast. 

COMPASSIN_E 3 Direction is East. 

COMPASSIN_SE 4 Direction is Southeast. 

COMPASSIN_S 5 Direction is South. 

COMPASSIN_SW 6 Direction is Southwest. 

COMPASSIN_W 7 Direction is West. 

COMPASSIN_NW 8 Direction is Northwest. 
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Terms & Conditions 
Quality Assurance 

A-WIT has stringent quality control procedures in place to insure the best quality 
products. 

90-Day Limited Warranty 

A-WIT Technologies, Inc warrants its products against defects in materials and 
workmanship for a period of 90 days. If you discover a defect, A-WIT Technologies, 
Inc. will, at its option, repair, replace, or refund the purchase price. After 90 days, 
products can still be sent in for repair or replacement, but there will be a $10.00USD 
minimum inspection/labor/repair fee (not including return shipping and handling 
charges). 

14-Day Money-Back Guarantee 

If, within 14 days of having received your product, you find that it does not suit your 
needs, you may return it for a refund. A-WIT will refund the purchase price of the 
product in the form of a check, excluding shipping/handling costs, once the product is 
received. This refund does not apply if the product has been altered or damaged. If you 
decide to return the products after the 14-day evaluation period, a 20% restocking fee 
will be charged against a credit. 

Disclaimer 

Warranty does not apply if the product has been altered, modified, or damaged. A-
WIT makes no other warranty of any kind, expressed or implied, including any 
warranty of merchantability, fitness of the product for any particular purpose even if 
that purpose is known to A-WIT, or any warranty relating to patents, trademarks, 
copyrights or other intellectual property. A-WIT shall not be liable for any injury, loss, 
damage, or loss of profits resulting from the handling or use of the product shipped.  

How to Return a Product 

When returning, you must first e-mail sales@a-wit.com for a Return Merchandise 
Authorization number. No packages will be accepted without the RMA number clearly 
marked on the outside of the package. After inspecting and testing, we will return your 
product, or its replacement using the same shipping method used to ship the product 
to A-WIT within 30 days. In your package, please include a daytime telephone number 
and a brief explanation of the problem. 

Please contact our Sales Department at sales@a-wit.com if you have any questions 
regarding our warranty policy or if you are requesting an RMA number. 
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